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Prerequisites 
This document assumes that you are familiar with the use of a computer keyboard and 
mouse and have a working knowledge of Microsoft Windows 
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About this Document 

Words in bold 
Will need to be typed or chosen from a menu 
or window 

Small capitals – e.g. ALT Indicate keys that you press 

Press KEY1 + KEY2 Press both keys together 

Press KEY1, KEY2 Press each key consecutively 

Bulleted lists Are guidelines on how to perform a task 

Choose Insert - Picture 
Show menu commands – in this case, choose 
the option Picture from the Insert menu at 
the top of the screen 

 





Intermediate Excel  Doc. 5.128 Ver 2 

 

1 Download a workbook 
Objectives Download a spreadsheet for use in the exercises that follow 

Method Use Internet Explorer to save the file from the CCS website 

Comments Right-clicking on a link brings up different options 

  

Activity 1.1 Internet Explorer 
If you have completed the beginners workshop and still have access to the 
spreadsheet you created then, open it and move straight to no.  2. 
 
We will use Internet Explorer to download a spreadsheet to save typing it 
from scratch 
 
• Open Internet Explorer 
• Browse to www.bbk.ac.uk/ccs/docs/resources 
• Right-click on the link to intexcel.xls and choose Save target as 
• Save the spreadsheet onto your n: drive 
• Open Excel 
• Open the spreadsheet you have just saved 
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2 Calculations 
Objectives To perform a simple calculation in Excel 

Method Use the function wizard to set up the calculation 

Comments 
In the beginners’ workshop we used the autosum command.  The function 
wizard gives access to the full range of Excel commands. 

  

Activity 2.1 The Function Wizard 
The function wizard gives easy access to Excel’s many types of calculation. 
 

• Click into the blank cell, A12, and add 
the word “Average” 

• Click into cell B12 
• Position the mouse over the = sign 

next to the Name box – the popup help 
tells you it is called “Edit formula” 

• Click on it 

Figure  2-1 

A new window pops up.  This is the function wizard. 
 
First we have to tell excel which calculation we want to carry out 
 

• Use the drop down arrow to select the word Average 
 

 

Figure  2-2 

The popup window changes appearance.  Excel will guess which values you 
want to work with, and should have filled in B2:B11 (note how Excel uses : to 
mean “to”).  We want to omit the fields calculating totals  
 

• Click into the Number1 box and change the 11 to an 8 
• Click OK 

 
Excel has now filled in the full function – bear in mind that it is very easy to 
forget to click “Average” at the beginning once you have used the function 
wizard a few times, leading to annoying #VALUE! errors 

• Repeat for C12 
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Activity 2.2 Repeated Formulae 
 
Although we have done so here, it is not necessary to use the function wizard 
for each value.  Excel is clever enough to understand that if you copy and 
paste a “Sum” from one column, you want to work with the values in the new 
column.  To see what I mean; 
 

• Click on C12 (the average expenditure for March) 
• Choose Edit – Copy   (or CTRL+C) 
• Click on D12 (which is blank at present) 
• Choose Edit – Paste   (or CTRL+V) 

 

Figure  2-3 

 
Note – as at the top right of Figure  2-3 – that when you pasted in the 
formula,  Excel changed it from C2:D8 to D2:E8 

Activity 2.3 The drag handle 
 
The drag handle – the box  at the bottom right of the active cell – can be used 
to repeat values across several cells.  It also works for formulae 
 

• Click on the drag handle in cell E12 
• Drag it across until all rows have their 

averages calculated 

 

Excel will automatically update the calculations 
- change some of the values to test it out. 
 
Have a look at the syntax of Excel formulae – 
note the = sign at the beginning, then the 
function to be performed, and finally, in 
brackets, the cells on which to perform it. 

Figure  2-4 

 
The list of functions is fairly comprehensive – have a look down and see if 
there are any others that might be of use to you. 
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3 Customising a Chart 
Objectives To change a chart’s appearance 

Method Double-click different areas of the chart to change those areas’ appearance 

Comments 
Excel charts are extremely customisable – clicking most parts will bring up 
different options, allowing you to change the colour, font, size or even 
remove a particular series or label. 

  

Activity 3.1 Font size 
 
The font sizes chosen by Excel may be a little too small relative to the size of 
the pie chart.  Changing them is similar but slightly different to Word, in that 
you do not select the text in the same way 
 
• Click on the tab for “chart1” at the bottom of the workbook 
• Click on the heading, Expenses for January 
• Use the drop-down menu to change the font to a larger size 
• Repeat for the legend at the side of the chart 
 
Note that you could instead have right-clicked on the text and chosen 
“Format Chart Title” or “Format Legend”, as appropriate 

Activity 3.2 Data series options 
 
There are different options for each area of the chart. 
 
• Double click on the pie-chart itself 
 
Doing so brings up the Data Series options.  Note that the first tab, patterns, 
is not very useful in this context, as we have selected all of the data series – 
changing colour here would change all slices of the pie to the new colour. 
 
• Click the Data Labels tab 
• Check the radio button to Show label and 

percent, as in Figure  3-1 
 
We don’t now need the legend, so it can be 
removed.  Either of the methods below will do so 
 
• Right-click on a blank area of the chart 
• Choose Chart Options 
• Click on the Legend tab 
• Untick the box next to Show Legend 
 
Or 
 
• Click on the Legend 
• Press the DELETE key 

Figure  3-1 
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Activity 3.3 Group vs Individual selection 
 
Some areas of the chart is made up of several different items – the legend 
and data labels are made up of different pieces of text, the pie chart of 
different slices – Excel allows you to select items as a group or individually. 
 
• Click on the pie chart itself 
 
That single click has selected the whole of the chart area – that is, all of the 
slices as a group. 
 
Selecting individual slices can be a little tricky – note that double-clicking in 
the same place brings up options for that area, rather than selecting that 
item. 
 
• Click again on one of the slices, in a different place to your first click 
 
You should now have selected just one slice of the pie chart – the black 
squares marking the current selection should be around the edge of the slice. 
 
• Click on a different slice 
 
Note that, now Excel has switched to allowing you to select one slice, each 
time you click it selects a 
different individual piece. 
 
• Double click on a slice 
 
This time the options, shown in 
Figure  3-2, apply only to that 
data series 
 
• Change the colour 
• Click OK 
• Change the colour of a 

different slice in the same 
way 

• Try dragging a slice out of 
the pie chart 

Figure  3-2 

Using the techniques above, it is possible to customise the appearance of 
your chart and give prominence to different information as necessary 
 
It is easy to get stuck selecting just individual areas of a chart.  To exit this 
mode of selection, either click somewhere neutral (e.g. on the background) 
on the chart, or press the ESCAPE key 
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4 Setting up a new sheet 
Objectives Set up a new worksheet to hold details of expenditure within a given month 

Method 
We will use and rename one of the worksheets already within the workbook 
and add columns 

Comments  

  

Activity 4.1 Renaming the worksheets 
Rename sheet1 – which holds our record of overall expenditure – to Overall, 
or similar 
 
• Double click on the tab for Sheet1 at 

the bottom of the screen – the text 
should be highlighted in black 

• Type in the new name 
• Hit RETURN 
• Double click on the tab for Sheet2 at the bottom of the screen 
• Type in the month – January 
• Hit RETURN 
 

Activity 4.2 January’s expenditure 
• Click on the tab to take you to the January worksheet 
• In the top-left cell, A1, enter “Date” 
 
We now need to add column headings for each of our expenditure categories.  
It is of course possible simply to type them in, but it is easier to copy and 
paste.  The immediate problem is that the categories are listed in a column 
on the first sheet, and we want them in a row, but Excel is able to 
swap them around for us. 
 
• Click on the tab to return to the Overall worksheet 
• Select the headings from Staffing – Advertising, as in Figure 

 4-1 
• Click on the copy icon (CTRL + C is the shortcut) 
• Click on the tab to change to the January worksheet 
 

Figure  4-1 

• Click into the first blank cell on the first row, 
which should be B1 

• From the Edit menu, choose Paste Special 
• You need not worry about any of the options 

that pop up, except the last – tick the box 
marked Transpose, as in Figure  4-2 

• Click OK 
 
The headings will be pasted into the row 
 
 

Figure  4-2 
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Activity 4.3 Entering Information 
We now have a very basic spreadsheet for recording expenditure, by date, 
throughout January.  Enter a few pieces of information. 
 
• In the first, blank, date field, type 20/1 
 
Note that Excel knows this means January.  If you click back onto the field, 
you will see at the top that it has also assumed a year of 2004, as in Figure 
 4-3 

 

Figure  4-3 

• Enter some more random dates and figures 
• Excel understands very abbreviated dates – for 1st January 2003, you 

may enter 1/1/3 
 
You should aim to have a grid something like that in Figure  4-4.  You may 
have an expense for more than one category in each row.  The order of the 
dates does not matter, and do not worry if excel changes the date format 
 

 

Figure  4-4 

Activity 4.4 Date Format 
Knowing we are entering dates, Excel has tried to apply a format to them.  It 
is not always consistent in doing so – see Figure  4-4 - and, in any case, may 
not be the format you prefer.  Excel allows you to use several different 
formats, without changing the information held 
in each cell. 
 
• Click on the column header, A, to select the 

whole column 
• Choose Format – Cells 
• Choose Date on the left-hand side 
• Pick a format on the right 
• Click OK 
 
 

Figure  4-5 

Because the whole column was selected, that format will now apply to all 
dates entered, no matter how many rows are used. 

Remember that you 
can select a block of 
cells, enter one value 
and then press CTRL + 

ENTER to add it to all 
selected cells.  Please 
use at least two dates 
in your example 
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5 Cross-sheet calculations 
Objectives 

To use the details within the sheet of January expenses to supply a total for 
each category on the overall sheet 

Method 
Use the formula wizard to create the calculation, switching sheets using the 
tab 

Comments You may use the autosum icon if you prefer 

  

Activity 5.1 Cross-sheet calculations 
Now that we have January’s expenses entered onto a separate sheet, we 
need to include the total for those values on the overall sheet – at present, 
we have to type the total in by hand. 
Excel will allow you to enter a calculation on one sheet which relies on values 
on a different sheet. 
 
• Click on the tab to return to the Overall sheet, if necessary 
• Click into January’s Staffing total, which should be cell B2 
• Delete the contents 
 
We will use the formula wizard to fill in the details we want 
 

• Click on the icon for the formula wizard 
• Use the drop down list to select SUM 
• The box that pops up may be dragged out of 

the way – click into a grey area and move it 
to the right-hand side of the screen 

• Click on the tab called “January” to move to 
the list of expenses 

Figure  5-1 

You could, at this point, select only the cells with data in them.  If setting this 
spreadsheet up as a template, though, it would be better to select the whole 
column, so that the total would take account of all entries made, whether 
there are 1 or 100 in a particular 
month 
 
• Click on the row header, B 
• Note that Excel fills in the 

necessary formula, as in Figure 
 5-2 

• Click OK 
 

Figure  5-2 

You will be returned to the overall sheet, with the total filled in.  Any changes 
or additions you make to the Staffing column on the sheet for January will be 
reflected in the total on the overall sheet. 
 
If you want to practice, repeat the above for one or two of the other 
categories on the overall sheet. 
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6 Sorting data 
Objectives To sort data in columns 

Method 
Use Excel’s sort function to specify which columns to sort by, and in which 
order 

Comments  

  

Activity 6.1 Selecting data 
 
Sorting information entered into an Excel spreadsheet is straightforward.  You 
may sort data by using the command on the Data menu, or by using the 

icons  to sort in ascending/descending order respectively. 
Using the menu command allows you to sort by more than one column at a 
time. 
 
• Click on the January tab to move to that 

worksheet 
• Click on a cell containing a number or a date 
• Choose Data – Sort 
 
Excel will bring up the sort dialogue box.  If it looks 
like Figure  6-1, with the bottom radio buttons 
greyed-out, click cancel and try selecting cell A2 and 
choosing Data – Sort again – sometimes Excel does 
not pick up the whole of the range of data. 

Figure  6-1 

Activity 6.2 Column headings 
 
Once Excel has spotted the range of data, it should see that the top row is a 
header – though note the options at 
the bottom to tell it explicitly. 
 
• Use the drop-down to pick a 

column to sort by 
• Choose a second column to sort by 
• Click OK 
 
Information may be reordered using 
Excel’s in-built sort function, whether 
it is numerical or textual. 

Figure  6-2 
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7 Filtering data 
Objectives Add a filter to a column of data in order to change the information displayed 

Method Use the AutoFilter command to add drop down lists to each heading 

Comments  

  

Activity 7.1 Autofilter 
 
Excel allows you to filter the information displayed on screen – very useful 
when you have long lists of data.  The autofilter function checks all the values 
in a column and adds them to a drop-down menu.  In our spreadsheet, we 
can use it to filter expenditure by date. 
 
• Make sure the active cell is somewhere 

within the data on the January sheet 
• Choose Data – Filter – Autofilter 

Figure  7-1 

Excel adds a drop-down list to the top of each heading, as in 
Figure  7-1 
 
• Click on the drop-down menu by the Date header 
 
As in Figure  7-2, the list of dates entered on the spreadsheet 
appears – any date not entered does not appear. 
 
• Select a date from the list 
 

Figure  7-2 

Only entries for that date will be shown 
 
Note the option to show All data 

Activity 7.2 Custom filter 
 
You are not restricted to showing only one item from the list. 
 
• Click on the drop-down next to Date 
• Click on Custom 
 
You may apply various different 
combinations here.  With textual 
information, you might choose to show all 
information except one value, with the 
“does not equal” option.  The “does not 
begin with” and “does not end” with 
options may also be useful. 

Figure  7-3 

• Select “is greater than” with the left-hand drop-down 
• Select a date using the right-hand drop-down menu, as in Figure  7-4 
• Click OK 
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Excel will show all information 
relating to dates greater than 
the one you picked.  The custom 
filter may be used for both text 
and numbers. 
 

Figure  7-4 

Activity 7.3 Switching off the filter 
 
To switch off the filter, select the option from the menu once more 
 
Note the tick to show the autofilter is switched on 
 
• Choose Data – Filter 
• Click on Autofilter 
 
The drop down menus disappear, and all the data is 
displayed 

Figure  7-5 
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8 Absolute References 
Objectives 

To perform a VAT calculation based a constant entered in one cell – allowing 
for the easy incorporation of future changes in the rate of VAT 

Method Use an absolute reference to the cell containing the VAT rate 

Comments  

  

Activity 8.1 Absolute vs relative 
 
We have already seen Excel’s use of relative references – when copying a 
formula (e.g.) from row b to row c, that formula is updated to perform 
calculations on the new row, not the old one. 
 
It is sometimes, however, useful to set an absolute reference, rather than a 
relative one; if calculating based on a constant number to apply a percentage 
increase, for instance. 
 
 

Activity 8.2 Setting the VAT rate 
 
• Click on the tab to switch to the Overall sheet 
• In a blank cell, e.g. A15, type “VAT rate” 
• Click into the cell next to it 
 
We will enter the VAT rate in this cell.  As you can see from the calculations 
in row 10, you may calculate 17.5% by multiplying by 0.175.  It is neatest to 
display the number as a percentage rather than a fraction, but if we use 
Format-cells to change the format of a cell, Excel will multiply the contents by 
100.  It is easiest, therefore to format the cell first. 
 
• Choose Format – Cells 
• Choose Percentage from the list of categories on the Number tab 
• Click OK 
• Enter the percentage – 17.5 – into the cell.  Note that Excel adds the 

trailing % sign 
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Activity 8.3 Amending the formula 
 
The above entry will make no difference to our calculations – partly because 
it is the same rate we have already used, and partly, of course, because our 
formulas do not refer to that cell. 
 
• Select the row containing VAT calculations (B10:M10) 
• Delete the contents 
 
We will now insert a new calculation, using the function wizard 
 
• Click on the icon ( ) to start the wizard 
• Choose SUM from the drop-down menu – note that even if SUM is already 

showing, you must click on it 
 
We now need to pick the cells containing the numbers to work with 
 
• Click on the subtotal for this 

column – B9 
• Enter a multiplication 

symbol - * 
• Click on the cell holding the 

VAT rate 
 
That formula will work, but we 
cannot copy it across cells, as 
Excel will update B15 to C15, 
D15 and so on.  We must make 
it an absolute reference 

Figure  8-1 

• With the cursor still flashing after B15, press the key F4 
 
Excel adds $ signs before both the column (B) and row (15) reference (you 
can just type them in, but the shortcut key makes it easier). 
 
• Click OK 
• Use the drag handle, or copy and paste, to repeat the formula across the 

row 
• Click on C10 
 
Note that the reference to B15 has stayed in place for all the other formulae, 
with that to B9 changing to C9 and so on. 
 
• Change the value in cell B15 
 
All the VAT totals change – as do the Total values, as they depend on the 
results of the VAT calculations. 
 
Setting a spreadsheet up in this way makes it simple to allow for future 
changes  
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9 Naming cells 
Objectives To give the VAT cell a distinctive name 

Method Use Excel’s Name box to rename a cell 

Comments 
Naming a cell – or range of cells – allows you to refer to it by name rather 
than cell reference.  Doing so is possibly of more use if you plan to type your 
formulae, but is invaluable if using lookup tables with the VLOOKUP function. 

  

Activity 9.1 The Name Box 
 
The name box is to the left of the function wizard 
we have used before, showing the reference of the 
active cell, as in Figure  9-1 
 

Figure  9-1 

• Click on cell B15 (which contains the VAT rate) 
• Click into the name box 
• Type the text, VAT 
• Press RETURN to confirm 
 
That cell has now been called VAT.  You may still refer to it as B15, but may 
also use the name just defined. 

Activity 9.2 Editing a formula by hand 
 
Our calculations of VAT still use the cell reference – Excel does not change 
them despite our naming cell B15 
 
• Click on cell B10 
 
To the right of the name box is the formula bar, showing =SUM(B9*$B$15) 
 
• Click into the formula (or press F2 to edit it on the worksheet) 

• Erase $B$15 and type VAT in its place  
• Hit RETURN to confirm your change 
 
Note the absence of $ marks – another benefit of naming the cell is that it 
explicitly marks that cell, so you no longer need to remember how to make a 
reference absolute 

 

14 Birkbeck College Central Computing Services 



Intermediate Excel  Doc. 5.128 Ver 2 

 

10 Customising the Toolbar 
Objectives To add useful buttons to the toolbar 

Method Use the Tools – Customise command to access the list of commands 

Comments Bear in mind that this technique may also be used in other Office applications 
  

Activity 10.1 Customise 
You may find that Excel has functions you 
use often but which are not on the 
toolbars.  It is straightforward to add 
most functions to whichever toolbar you 
like. 
 
• Choose Tools – Customise 
 
Commands are listed by menu 
 
• Click on the Insert category on the left 
• Drag the Cells command onto the 

toolbar 

Figure  10-1 

• The black marker, as at the top of , shows where the icon will be placed 
• Click Close when you have finished 

Activity 10.2 Toolbars 
When first installed, Excel (and Word) will usually put both the default 
toolbars on the same line with the effect that, on all but the biggest screens, 
some of the icons are hidden.  To display both toolbars in full; 
 
• Look for the grey bar, somewhere near the middle of the toolbar 

 
• Click and drag the bar down below the other toolbar 
 
If you drag the toolbar too far, it will be turned 
into a “floating” toolbar, with its own blue title bar 
– drag it up to the top of the screen to make it 
snap into place again. 
 
You may drag toolbars to either side of the screen 
if you prefer. 
 
Should you lose a toolbar, or want an additional 
one; 
 
• Choose View – Toolbars 
• Click on the toolbar you require 
 
The two default toolbars are “Standard” and 
“Formatting” 

Figure  10-2 
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11 Freezing parts of the screen 
Objectives Fix part of the screen in place so it is always visible when scrolling 

Method Click into the spreadsheet and use the Freeze panes command 

Comments  

  

Activity 11.1 Freeze panes 
 
It is often useful to be able to keep part of your spreadsheet visible; keeping 
the header row in sight as you scroll down, for instance.  To do so you need 
to click below (for rows) and/or to the right (for columns) of the data you 
want to keep in view 
 
• Click into cell A2 
• Choose Window – Freeze panes 
 
A thin black line has appeared across the top of that row – you may not be 
able to see it if you have a border there already 
 
• Scroll down the spreadsheet 
 
The first row is kept in place. 
 
You may also achieve the same effect by first choosing Window – Split, and 
then Window – Freeze panes.  The advantage is that the split lines added 
may be moved around the worksheet.  The disadvantage is that you will need 
to choose Window – Unfreeze panes and Window – Remove split to remove the 
marker lines. 
 

 
 

12 Changing Default Chart Settings 
Objectives To change the chart that Excel selects when the chart wizard is started 

Method Use the autosum icon to create the calculation, switching sheets using the tab 

Comments  

  

Activity 12.1 Default chart settings 
As you may have noticed, Excel automatically starts with a Clustered Column 
chart.  While working through the wizard and changing options does not take 
long, you will probably find that you use one type of graph more than others.  
It is possible to set options so they take effect by default, saving you time. 
 
First we need to create a chart, formatted as we want it.  We will create a pie 
chart to compare values within one category 
 
• Select the data in one row, as in Figure  12-1 
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Figure  12-1 

 
 
 
• Click the chart wizard button 
• Choose a 3-d pie, as in Figure  12-2 
 
 
 
 
 

Figure  12-2 

• Click Next 
• Click Next to go to step 3 
• Set the legend to appear on the 

left 
• On the data labels tab, choose 

Show label and percent 
• Click Next 
 
 
 

Figure  12-3 

• Insert the chart as a new sheet, and give that sheet its own name 
• Click Finish 

Activity 12.2 Selecting a chart as the default 
Now that we have formatted and inserted a chart 
as we want it, we need to tell Excel to use this 
type of chart in the future. 
 
• Right-click in a clear area of the chart 
• From the popup menu, choose Chart type 
• Click on the Custom Types tab 
• Click on the Set as default chart button at the 

bottom left 
• The dialogue box in Figure  12-5 will appear – 

click Yes 

Figure  12-4 

 

Figure  12-5 

• You will now be asked to give your chart-type a name – you should be 
sure it will make sense to you in the future, as you might want to set up 
different custom formats 

• Click OK 
• You may either OK or cancel the chart type window – it does not matter, 

as you have already set the default 
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Activity 12.3 Custom vs Standard types of chart 
 
You may have noticed that there is a “set as default chart” option on the 
“standard types” tab (see Figure  12-4).  Whilst you can set the default chart 
from here, it will only change the type of chart; it will not preserve any 
other formatting changes you have made. 
 
The benefits of setting a different default chart type should be that you can 
simply select data, click the chart wizard and then click Finish rather than go 
through each step separately, as your legend, data series options etc will be 
set for you.  If you find yourself producing different charts each time, setting 
a new default may not help, though you might usefully be able to set font 
size and so on. 
 

Selecting data and then pressing F11 will immediately insert a 
chart based on your default settings 
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